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Overview of Project 
 
Students will create an online trek across the United States.  They will receive instruction on use 
of the Internet and then be asked to research and compile information in small groups relating to 
a particular location in the U.S.  Group members will report on geography, early inhabitants, 
history, and famous Americans from that place.  Additionally, students will create illustrations 
and upload their research to the Internet using templates and a web editor program.  Groups will 
repeat 4-6 times during the school year, rotating tasks each time. 
 
 

Objectives for Students 
 
Students will be able to: 
 
 ? Conduct a search of the Internet to gather information of a specific topic 
 ? Organize research into notes 
 ? Create an organized composition, including the information recorded in notes 
 ? Edit composition into html using a web-editing template 
 ? Upload page onto class hosted site for US Web Trek 
 
 

National Board Certification 
 
Middle Childhood Generalist (grade level 5) 
Curriculum 
Standards: 

II.  Knowledge of Content 
 V.  Instructional Resources  
 VII.  Multiple Paths to Knowledge 
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Resources 
 
? Internet-accessible computers (lab for whole-class instruction, and classroom computers for 
group work) 
? Web page editing software with pre-designed templates for each section of project 
? Research guides 
? Rubrics 
? Self-evaluation 
 
 

Background Information (Optional) 
 
My class has developed a tracking program that will mirror the Web Trek project and provide 
interest while assisting in location selection for the project.  At the beginning of the year, puppets 
sent out with people traveling within the country.  Each of the puppets represents an early 
cultural group found in America during the periods of exploration or colonization.  The puppets 
include a Native American boy, an African girl in traditional garb, an Inuit girl, and an American 
“cowboy”.  Students are introduced to these puppets early in the year and help develop a history 
for each.   
 
The puppets travel throughout the country with people on business trips or via post and discover 
the present civilizations.  They compare how life is today with how life was in early America and 
the changes that have occurred over time.  The journeys of the puppets are charted on a large 
map in the classroom.  People that travel with the puppets are asked to take a picture of puppet at 
the location (using the camera included), record what the puppets’ thoughts might be (in a field 
journal), and send a postcard (written from the perspective of the puppet) to the class.   
 
Students may then be assigned locations to research based on the postcards that are received or 
supplemented with other historical sites. 
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Project Description 
 
This Web Trek is designed to help familiarize students with the use of the Internet as a research 
and publishing media.  While using the Internet as a tool, students will be expanding their 
knowledge of United States geography and history while working cooperatively with their peers 
to present a finished project several times during the year.  By working in groups, it will help 
foster a sense of individual responsibility, leadership, and time management. 
 
Students will develop an online tour of locations across the United States as a Web Trek of the 
country.  Students will research various locations and submit entries to be placed on the class site 
using templates and a simple web-editing program.  Students will work in small groups of about 
6 members to submit between 4 and 6 reports during the school year. 
 
Each group member will be assigned a task to complete. 
 ? Geography of place (land regions, climate, physical features, surrounding area,  etc.) 
 ? Early inhabitants and lifestyle/culture of the inhabitants 
 ? Brief history of the place 
 ? Short biographical accounts of 3 noted residents/contributors of the place/region 
 ? Illustrations (a map of the area and a picture of what you might see) 
 ? Web Editor (gathers materials and compiles the page) 
 
Students will spend the first one to two months of the school year receiving instruction in a 
computer lab setting.  They will be instructed in how to use the Internet to conduct a search using 
scavenger hunts and worksheets with step-by-step instructions, to gather data and record notes, 
and to use a web editor template to create a web page representing their research. 
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Timeline of Project 
 
September-October Introduce project.  Instruct students in computer lab to conduct effective 

searches.  Teach students to use web editor.  Orient students to each of the 
tasks/roles for the project. 

 
November Students conduct first location report.  Each member of group is assigned 

a different part of the report to research and complete.  Upload pages to 
site. 

 
January Second location report.  Upload pages to site. 
 
Late February Third location report.  Upload pages to site. 
 
Early April Fourth location report.  Upload pages to site. 
 
May Fifth location report.  Upload pages to site. 
 
June Report on year.  Assessment. 
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How to Replicate Project 
 
The project is easily replicated, but may require some background information to be given to the 
group of students.  The purpose of the project is to create a virtual tour of the United States and 
some of its historical or popular cities and locations.  California’s fifth grade curriculum for 
Social Studies includes an exploration of America from its earliest inhabitants, through the age 
of exploration, European colonization, and independence.  The web trek should support that 
curriculum by providing an opportunity for a study in how famous places today have developed 
from their earlier inhabitants through its historical events and famous citizens.  Through this 
study, students will gain a greater understanding of what makes some of our US cities special. 
 
Students will need to be instructed in the use of search engines and web page editors, since they 
will be asked to use these tools independently during the course of the year.  To best facilitate 
this instruction, the use of a computer lab will be necessary.  Students will use guides and 
scavenger hunts to help them navigate through these tools and provide an evaluation tool to 
measure how successful they are in using both of these tools.  To aid in replication by fellow 
educators, the guides, worksheets, and rubrics are included.   
 
The choice of web-editing software may be varied depending on what is available to students at a 
particular site.  Programs like Microsoft Frontpage or Dreamweaver could be used, but may be 
too advanced for students to use without causing frustration.  It may be advisable to use a word 
processing program like Microsoft Word or Apple Works to create templates the students may 
use.  The documents would then be saved in an HTML file format and uploaded to your 
webpage. 
 
It is not necessary to follow the timeline provided.  Depending on how soon students are able to 
demonstrate proficiency in web editing and Boolean searches, you may be able to complete more 
or less reports during the course of the academic year.  It is anticipated that most classes should 
be able to complete four to six different reports in a year.  Pacing should be adjusted, however, to 
accommodate individual student needs and computer problems.   
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Guides and Forms 
 
 

? Internet Search Guide 
? Web Editing Step-by-step 
? Geography Page Guide 
? Early Inhabitants Guide 
? History Guide 
? Biographies Guide 
? Illustrator Guide 
? Works Cited and Online References 
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Student Name _____________________________________________  Date _______________ 
 

Internet Search Guide 
 

Step Instructions Requested Information 
1 Go to Yahooligans (www.yahooligans.com).  -------------------------------------------------- 
2 Search a category.  Click on the Around the World 

link in the Yahooligans! Directory.  Choose the 
sub-category for U.S. States on the next page.  How 
many sites are there for the state of California? 

 

3 At the bottom of the page that lists all the states, 
find a link to the site Stately Knowledge.  Go there.  
What is the origin of the name “California”? 

 

4 Return to Yahooligans (www.yahooligans.com).  
Using the category of School Bell, find a website 
that offers homework help.  Check out the site.  
Write down the URL. 

 
http:// 

5 Go back to Yahooligans (www.yahooligans.com).  
Select the Animals sub-category of the Science and 
Nature category.  Search just that category for 
“kiwi”.  Find out where kiwis are found? 

 

6 Try a natural language search.  Go to Ask Jeeves 
(www.ask.com) and type a question, “What time is 
it in Korea?”  Find the current time and date in 
Seoul, South Korea. 

 

7 Try another search on Ask Jeeves.  Find out why 
hot air balloons float.  Record your answer using 
one to seven words. 

 

8 Suppose you want to gather some information 
about knights.  Go to www.looksmart.com and 
search for “knights”.  How many websites are 
found with the word “knights” in them? 

 

9 Narrow your search.  At LookSmart, enter a search 
using the phrase “knights of the round table”.  How 
many websites are found with that phrase? 

 

10 Go to Yahoo (www.yahoo.com).  You want to 
search for an Australian animal that is a marsupial, 
but is not a kangaroo.  Enter “australia” then a plus 
sign (+) followed by “marsupial” to show that the 
search results must include marsupial and a minus 
sign (-) followed by kangaroo to say that the results 
should not include kangaroos.  Record the common 
name and scientific name of an Australian 
marsupial. 

 

11 Use Yahooligans (www.yahooligans.com), Ask 
Jeeves (www.ask.com) or Yahoo 
(www.yahoo.com) to search for the actual number 
of legs a centipede has.  Record the number. 
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Web Editing Step-by-Step 
 

1. Go to the Documents folder on the desktop and open the file: Sample Page.  Double click 
on the name of the file to open it. 

 
2. This file is a word processing document that you will edit using Microsoft Word.  It is a 

template, which means that the format you see on your monitor is a pattern for the 
webpage you are going to create.  The layout is going to be the same, but you are going 
to enter some information of your own to change what the page says.  

 
3. First, you need to change the title at the top of the page.  Click once on the title and a text 

box should appear.  Click and drag over the text in the box to highlight it.  Press the 
delete key to clear the field.  Type your new text into the box, which will be the title of a 
favorite novel. 

 
4. Below the title box, is a smaller line of text.  Follow the same procedure to select the text 

and enter the new text, which will be the name of the author of the book and your name 
(First name and last initial only).  Change the font size to 16 points.  Highlight your new 
text and select from the Format menu Font, and then choose the Size of 16.  

 
5. On the left side of the page is a text box where you will enter a brief summary of the 

book.  This should be no more than four sentences and should include a description of 
where the story takes place, the main character, and the basic plot.  It is not necessary to 
go into great detail about the story. 

 
6. On the right side of the page is another text box where you will list three (3) favorite 

things about the story you read.  At the top, type: What I Liked Best about this Story.  
You will create a bulleted list for each of your three favorite things about the story.  The 
template already has bullets and you need to enter your favorite things in place of the text 
that is already listed.  Now, you will format the title of the list, which is the top line 
where it says “What I Liked Best about this Story”.  Change the font size to an 18-point 
font for the first line.  On the Format menu at the top of the screen, select Paragraph.  
Select the drop box for Alignment and select Centered.  This will center your text in the 
text box.   

 
7. The last change you will make to this page is to add an appropriate image. You will 

replace the picture of the camera on the bottom of the page with a picture that represents 
something in the story.  Click once on the picture of the camera to select it.  Then, with 
the camera still highlighted, go to the Insert menu at the top of the page and choose the 
option for Picture and Clip Art from the menu that open to its right.  Select a picture that 
you would like to use to represent your novel and double click on it or select Open. 

 
8. You should now have your picture on the page where the camera had been.  Your picture 

may be huge, though, so you will need to resize it.  To resize, click once on the picture to 
highlight it.  You should see small squares on the corners of the picture.  Click on one of 
the squares and drag it to make your picture smaller to about the size of the camera. 

 
9. On the File menu, select Save As… and save the page as an html file of your name. 
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Student Name _____________________________________________  Date _______________ 
 

Geography Page Guide 
 
 
 
 
 
 
 
 
 
 
 
Location: ______________________________________________ 
 

I. U.S. region of location:  
 
 
 
II. What physical features shape the land in and around this location? 

 
 
 
 
 
 
 

III. What is the surrounding area like?  (land forms, regions, urban/suburban, etc.) 
 
 
 
 
 
 
 
 
 

IV. What is the climate like?  (temperature, precipitation, etc.) 
 
 
 
 
 

V. What is the population and population density? 
 
 

It is your responsibility to research and record information about the geography of your 
assigned location.  You will need to be thorough, yet concise.  You will need to gather 
information about the land regions and physical features of the place, the surrounding area, 
climate, nearby landforms, and how the geography affects the culture of this location.  Use 
this page to help you organize your information.  After collecting your information, you 
should organize your notes into approximately one to three paragraphs that will be typed and 
submitted for publication on the class Web Trek site. 
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Student Name _____________________________________________  Date _______________ 
 

Early Inhabitants Guide 
 
 
 
 
 
 
 
 
 
 
Location: ______________________________________________ 
 

I. What group/tribe of people (native Americans) were the early 
inhabitants of this place? 

 
 
 

II. What area (present-day states) did they occupy? 
 
 
 

III. What type of housing did they dwell in? 
 
 
 
 
 

IV. What traditions did they observe in their culture? 
 
 
 
 
 
 

V. Describe their religious beliefs/practices/traditions. 
 
 
 
 

VI. How was their society governed?  What kind of leadership was there? 
 
 
 
VII. What became of this group of people? 

It is your responsibility to research and record information about the early inhabitants of 
your assigned location.  You will need to be thorough, yet concise.  You will need to gather 
information about the early, Native American inhabitants.  Describe their lifestyle, housing, 
traditions, religions, and government.  Use this page to help you organize your research.  
After collecting your information, you should organize your notes into approximately one to 
three paragraphs that will be typed and submitted for publication on the class Web Trek site. 



 13

Student Name _____________________________________________  Date _______________ 
 

History Guide 
 
 
 
 
 
 
 
 
 
 
 
Location: ______________________________________________ 
 

I. Who were the first explorers or settlers to arrive in this location? 
 
 
 

II. What country first claimed this territory?  When? 
 
 
 
 

III. When did the state become a state? (When was it admitted to the Union?) 
 
 
 

IV. What are some events and dates that are important to the development/growth of this 
location?  List them below.  Include some detail about each and how it was important 
to this location. 

 
 
 
 
 
 
 

 
 
 

It is your responsibility to research and record information about the history of your assigned 
location.  You will need to be thorough, yet concise.  You will need to gather information 
about the history of your location.  Include information on who the first explorers or settlers 
to arrive in this location were, what country claimed the territory, when it became a territory, 
when the state received its statehood, any important dates, and any important events.  Use 
this page to help you organize your research.  After collecting the information, you should 
organize your notes into approximately one to three paragraphs that will be typed and 
submitted for publication on the class Web Trek site. 
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Student Name _____________________________________________  Date _______________ 
 

Biographies Guide 
 
 
 
 
 
 
 
 
 
 
 
Location: ______________________________________________ 
 

I. Person #1 
A. Date of birth: 

 
B. Place of origin: 

 
C. What are they remembered for? 

 
 
 

D. What became of them? 
 

II. Person #2 
A. Date of birth: 

 
B. Place of origin: 

 
C. What are they remembered for? 

 
 
 

D. What became of them? 
 

III. Person #3 
A. Date of birth: 

 
B. Place of origin: 

 
C. What are they remembered for? 

 
 
 

D. What became of them? 

It is your responsibility to research and record some biographical information about three 
noted persons for your assigned location.  You will need to be thorough, yet concise.  You will 
need to gather information about each of the people’s birth, place of origin, what they are 
remembered for, and what became of them, including their deaths.  Use this page to help you 
organize your research.  After collecting the information, you should organize your notes into 
approximately one to three paragraphs that will be typed and submitted for publication on the 
class Web Trek site. 
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Student Name _____________________________________________  Date _______________ 
 

Illustrator Guide 
 
 
 
 
 
 
 
 
 
 
 
Location: ______________________________________________ 
 
You may use this space to brainstorm ideas and/or sketch what you  
plan to draw. 

It is your responsibility to create two illustrations for the pages of your group’s project.  
First, you will need a map of the area, which includes landforms, major cities, and 
waterways.  The second illustration should be one of your choosing, but should reflect 
something of interest or significance for this location (landmark, famous building, famous 
person, symbol of location, etc.).  Pictures should be neat and in color.  Size should be 
between 6” x 6” to standard paper size 8.5” x 11”.  Pictures will be scanned into the 
computer and uploaded to the site.   
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Student Name _____________________________________________  Date _______________ 
 

Works Cited and Online References 
 
 
 
 
 
 
 
 
Author (last name, first name).  “Title of Website” 
URL:  http://_______________________________________ 
Viewed: (date) 
 
Example: 
 

Baer, John. "The Pledge of Allegiance - A Short History."  
URL: http://www.vineyard.net/vineyard/history/pledge.htm.  
Viewed: 10-04-2001. 
 

Works Cited 
 
Author ______________________________ Title “___________________________________” 
 
URL:  http://_____________________________________________________ 
 
Viewed: ________________________ 
 
 
Author ______________________________ Title “___________________________________” 
 
URL:  http://_____________________________________________________ 
 
Viewed: ________________________ 
 
 
Author ______________________________ Title “___________________________________” 
 
URL:  http://_____________________________________________________ 
 
Viewed: ________________________ 
 
 
Author ______________________________ Title “___________________________________” 
 
URL:  http://_____________________________________________________ 
 
Viewed: ________________________ 

Cite the websites that you visit and get information from in the format shown below.  All 
groups’ members’ sources will be combined on the published pages and will be listed in 
alphabetical order by the author’s last name.  If you can’t find an author for a site, list the 
title and alphabetize those after the sites with authors. 



 17

Assessment and Evaluation 
 
 

? Researcher Grading Rubric 
? Illustrator Grading Rubric 
? Web Editor Grading Rubric 
? Self-Evaluation
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Exploring Liberty: A Web Trek 
 Researcher Grading Rubric 

 
Student Name __________________________________________   

Location ______________________________________________ 

Role of Student: ____________________________________________ 

CATEGORY 4 3 2 1 
Content All required 

information is 
included and 
well represented.  
Student’s 
research exceeds 
minimum 
requirement. 

All required 
information is 
included and well 
represented, but 
does not reflect 
effort beyond 
requirements. 

Most of the 
required 
information is 
included.   

Required 
information is 
missing, 
incomplete, or 
incorrect. 

Quality of Work Provides work of 
the highest 
quality. 

Provides high 
quality work. 

Provides passing 
quality work. 

Provides work 
that needs to be 
checked or 
redone to ensure 
quality. 
 
 

Grammar and 
Mechanics 

Writing contains 
no grammatical 
or mechanical 
errors. 

Writing contains 
few (1-2) 
grammatical or 
mechanical 
errors. 

Writing contains 
several (3-4) 
grammatical or 
mechanical 
errors. 

Writing has 
repeated 
grammatical and 
mechanical 
errors.  Does not 
reflect editing 
and revising. 

Focus on the 
Task 

Consistently 
stays focused on 
the task and 
what needs to be 
done.  Self-
directed. 

Focuses on the 
task and what 
needs to be done 
most of the time.  
Group members 
can count on this 
person. 

Focuses on the 
task and what 
needs to be done 
some of the 
time.  Must be 
reminded 
sometimes. 

Rarely focuses 
on the task and 
what needs to be 
done.  Lets 
others do the 
work. 

Pride Work reflects 
this student’s 
best efforts. 

Work reflects a 
strong effort from 
this student. 

Work reflects 
some effort from 
this student. 

Work reflects 
very little effort 
on the part of 
this student. 
 
 

 

Total Score: ________  Grade: ________ 
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Exploring Liberty: A Web Trek 
Illustrator Grading Rubric 

 
Student Name ______________________________________ 

Location __________________________________________ 

Role of Student: Illustrator 

Category 4 3 2 1 
Content All required 

information is 
included and well 
represented.  
Student’s work 
exceeds the 
minimum 
requirement. 

All required 
information is 
included and well 
represented, but 
does not reflect 
effort beyond 
requirements. 

Most of the 
required 
information is 
included.   

Required 
information is 
missing, 
incomplete, or 
incorrect. 

Quality of 
Work 

Provides work of 
the highest 
quality. 

Provides high 
quality work. 

Provides passing 
quality work. 

Provides work 
that needs to be 
checked or 
redone to ensure 
quality. 
 
 

Captions and 
Labels 

Detailed, yet 
concise captions 
provided for both 
illustrations.  
Map is clearly 
labeled.   

Captions provided 
for both 
illustrations.  
Labels may not be 
very clear. 

Captions 
provided for both 
illustrations, 
though may be 
weak.  Labels 
may not be clear. 

Captions are 
incomplete or 
missing and 
labels are absent 
or hard to read. 

Focus on the 
Task 

Consistently 
stays focused on 
the task and what 
needs to be done.  
Self-directed. 

Focuses on the 
task and what 
needs to be done 
most of the time.  
Group members 
can count on this 
person. 

Focuses on the 
task and what 
needs to be done 
some of the time.  
Must be 
reminded 
sometimes. 

Rarely focuses 
on the task and 
what needs to be 
done.  Lets 
others do the 
work. 

Pride Work reflects this 
student’s best 
efforts. 

Work reflects a 
strong effort from 
this student. 

Work reflects 
some effort from 
this student. 

Work reflects 
very little effort 
on the part of 
this student. 
 
 

 

Total Score: ________  Grade: ________ 
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Exploring Liberty: A Web Trek 
Web Editor Grading Rubric 

 
Student Name ______________________________________ 

Location __________________________________________ 

Role of Student: Web Editor 

Category 4 3 2 1 
Content and 
Format 

All required 
information is 
included and well 
represented.  
Information is 
well organized 
and displayed. 

All required 
information is 
included and well 
represented, but 
does not reflect 
effort beyond 
requirements. 

Most of the 
required 
information is 
included.   

Required 
information is 
missing, 
incomplete, or 
incorrect. 

Quality of 
Work 

Provides work of 
the highest 
quality. 

Provides high 
quality work. 

Provides passing 
quality work. 

Provides work 
that needs to be 
checked or 
redone to ensure 
quality. 
 
 

Uploads—Time 
Management 

All pages are 
uploaded by the 
deadline.  Self-
directed timeline.  
Makes sure all 
submissions are 
ready to upload.   

All pages are 
uploaded by the 
deadline, but 
added pressure at 
end to have it 
completed on 
time. 

Most pages 
uploaded by 
deadline.  May 
need to nag and 
remind other 
group members.  

Several pages 
may not be 
uploaded by 
deadline. 

Focus on the 
Task 

Consistently stays 
focused on the 
task and what 
needs to be done.  
Self-directed. 

Focuses on the 
task and what 
needs to be done 
most of the time.  
Group members 
can count on this 
person. 

Focuses on the 
task and what 
needs to be done 
some of the time.  
Must be 
reminded 
sometimes. 

Rarely focuses 
on the task and 
what needs to be 
done.  Lets 
others do the 
work. 

Pride Work reflects this 
student’s best 
efforts. 

Work reflects a 
strong effort from 
this student. 

Work reflects 
some effort from 
this student. 

Work reflects 
very little effort 
on the part of 
this student. 
 
 

 
 Total Score: ________  Grade: ________ 
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Self-Evaluation 
 
Name _______________________________________________ 

Location ____________________________________________ 

Role __________________________________________ 

 
1. Describe what you did to contribute to the project individually. 

 
 
 
 
 
 

2. What contributions did you make to the group? 
 
 
 
 
 
 

3. List what skills you used to complete this project. 
 
 
 
 

4. What grade do you think you deserve (individually) on this project? ___________ 
 

5. Why do you feel you should be awarded this grade?  Explain below. 
 
 
 
 
 
 
 

6. What grade do you think your group deserves on the project? ___________ 
 

7. Why do you feel you should be awarded this grade?  Explain below. 
 
 
 
 
 
 
 
 
 
 


